Starting and Ending a Word Processing Program
The Meaning of Word Processing
Explain the Meaning of Word Processing
Word processing is the process of creating,editing,storing and printing typed documents.One is ableto write text, store it electronically, display it on a screen, modify it by enteringcommandsand characters from the keyboard, and print it.
The Importance of Word Processing
Explain the Importance of Word Processing
The importance of word processing are as following:
· Saves time— Word processing helps teachers use preparation time more efficiently by letting them modify materials instead of creating new ones. Writers can also make corrections to word processing documents more quickly than they could on a typewriter or by hand.
· Enhances document appearance— Materials created with word processing software look more polished and professional than handwritten or typed materials do.
· Allows sharing of documents— Word processing allows materials to be shared easily among writers. Teachers can exchange lesson plans, worksheets, or other materials on disk and modify them to fit their needs. Students can also share ideas and products among themselves.
· Allows collaboration of documents— Especially since the release of Google Docs, teachers and students can now create, edit, and share documents synchronously.
Start and End a Word Processing Program
Start and End a Word Processing Program
STARTING MICROSOFT WORD
· There are two alternatives.
· Alternative 1, Using start button
· Click start button, the menu will appear
· Start all programs
· Select Microsoft office, the group menu will appear.
· Double click Microsoft word 2003-2016 the window will appear
· Alternative 2,Using keyboard
· Press window log key.
· Select all programs for double click on Microsoft word 2003-2016
· NOTE:If you select all programs follows procedure 3 and 4 above other wise
· The window will appear.
Create a Word Processing File
Create a Word Processing File
CREATING DOCUMENT USING MICROSOFT WORD
· Microsoft word, commonly referred to as word, is the most common word processor. The five commonly used versions of word 97, 2000, 2002(XP), 2003, 2007, 2010, 2013 and 2016. While word 97-2003 look alike and are compatible, word 2007 radically divorces from these in the look and manually out, there is no file menu and once text is highlighted a float formatting tool bar is displayed above the selected text. More over document saved in 2007 format cannot be opened in previous version unless you saved the file in compatibility mode for consistency: we shall use the word processing software called Microsoft word 2003.
· Typing text: When typing, once the cursor reaches the end of the current line automatically jump to the next line. If one word does not in current line automatically wraps at the beginning of the next line. This is referred as word wrap.
Save a Word Processing File
Save a Word Processing File
Saving file
· On the menu, click the “save as” command
· Select the storage location from the “save in” list box
· Type the name of the file in the “file name” box the click “ok”
Close a Word Processing File
Close a Word Processing File
Open a Word Processing File

Editing and Formatting
Editing a Word Document
Editing a Word Document
EDITING A DOCUMENT 
· Making changes or modifying an existing document is called editing, some editing operations includes;
Deleting text
· To delete a character, a word or a block of text
· Highlight the text to be deleted
· Press the “delete” key or the “backspace” key
Find and replace
· Find and replace is used to locate a word or a phrase and replace the target word or phrase.
Spelling and grammar checker
· Spelling and grammar checker automatically locate misspelled words and grammatical mistakes
· Check a document spelling and grammar
· On tools menu bar click spelling and grammar or press F7
· In the spelling and grammar dialog bar. Misplace words are shown in red while grammatically incorrect phrases are in green.
· From the suggestion list, select the correct spelling and grammar.
· Click change (all) button. To ignore, click the ignore (all) button.
LIMITATION OF SPELL CHECKER
· Names of people and places are not usually included.
· The same two words in a row may not be deleted
· If a word is spelled incorrectly but used in the wrong context it will not be deleted
· Quality of dictionaries can vary
Thesaurus 
· The thesaurus allow the user to automatically find the words or phrases with similar meaning (synonyms) or opposite meaning (antonyms) to the one deleted.
To use the thesaurus
· On the insert menu, point to auto text and then click auto text command.
· Click the auto correct or auto text tab and type the auto correct or auto text.
· Click to apply and close the dialog box.
Undo and Redo
· Undo reverses the most recently command while redo reverts back to the cancelled action.
· Click the edit menu, click undo or redo. Alternatively, press ctrl + Z to undo or ctrl + Y to redo
Format a Word Document
Format a Word Document
Formatting refers to enhancing the appearance of the document. You format text, paragraphs, pages, or the entire document.
Text formatting
· We format text by applying different font types, style, size, color and another attributes.
Text font
· To format text font 
· Highlight the text to be formatted 
· On the format menu, click font 
· In the font dialog box, select the font, style, size and color
· Apply other font attributes then click ok
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Font Dialog Box
Case
· The cases applied to text are: lower case, upper case, sentence case, title case and toggle. The use of case in these sentences is deliberate
To change case
· Highlight the text
· On the format menu, click change case
· In the change case dialog box, select case then click ok
Superscript and subscript
· Superscript appears just above the rest of the character as in cm2 superscript.Subscript appears just below other characters as in H2O subscript
To make text superscript or subscript
· Highlight characters
· On the format menu click font
· On the font dialog box check superscript or subscript
Paragraph of formatting
· A paragraph is a separate block of text dealing with a single theme and starting on a new line or what. Some of the formatting features you can apply in to a paragraph include alignment, setting tabs and indents, drop cap, bullets and numbering, line, spacing, inserting column and page breaks.
· Alignment is the arrangement of text relative to the left margin, Center of the page or the right or the right margin. The five major alignment options available are the left, center, right, justified and forced justified.
To align text
· Highlight the text
· On the format menu click paragraph.
· In the dialog box, select the alignment option then click ok
Note: you can apply alignment by simply clicking any of the five alignment buttons on the formatting toolbar
Line spacing 
· You can set the space between line, paragraphs or blocks of text
To space line 
· Highlight the lines of text
· On the format menu, click paragraphs dialog box.
· In the paragraph dialog box, select the line spacing option from the line spacing list box then click ok button
Setting tabs and indents
· Tab refers to definite cursor stop when the tab key is pressed. Indenting is moving a sentences or block of text away from the margin using the tab key.
To set tabs and indents
· On the format menu click tabs
· In the dialog box, set the tab stop, alignment and leading then click ok
· Press the tab key to increase or the space bar to decrease the indent.
· Alternatively click the increase/decrease indent buttons on the formatting tool bar.
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Drop cap
· A drop cap is a large character in a paragraph that occupies more than one line down.
To create a dropped cap
· Highlight the paragraph you want to begin with drop cap
· On the format menu, click drop cap
· Click dropped or in margin
· Specify the number of lines & other options then click ok
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BULLETS AND NUMBERING
· Bullets and numbers are used to create ordered list
To add bullets or numbers.
· Highlight the text
· On the format menu, click columns
· In the columns dialog box enter the number of columns, set the column width then click ok
PAGE AND COLUMN BREAKS
· Page, section and column breaks are to force the cursor to a new page section or column even before the end of the current.
To insert a break.
· Position the insertion pointer where you back want to create a break
· On the insert menu, click break
· In the break dialog, set the break type the ok
PAGE SETUP
· Page setup options let you define the paper size, margins and operations.
To set up a page
· On the file menu, click page setup
· In the page setup dialog box
· Click any of the following; Margins tab to set up page margins,Paper tab to specify the paper type and orientation and Layout tab to specify the page content layout relative to the margins
· Click to apply the setting
PAGE NUMBERING
· Page numbers are used to organize a large document for case of reference
To insert page numbers
· On the start menu, click page numbers
· In the position box, specify whether to place the page numbers at the top of page (header) or at the bottom of the page (footer)
· In the alignment box-specify whether to align page numbers to the left, center or right of the page
· If you don’t what a number on the first page, clear the show number on the first page check the box then click ok
· Note: click on the format button to specify other page options such as numbering type and font.
HEADER AND FOOTER
· Header are lines of text that appear at the top margin every page or selected pages while footer appear at the bottom margin
To insert header and footer
· On the view menu, click header and footer
· To create a header, enter text or graphical object in the header area
· To create footer, click inside the footer area and enter the text or graphical object
· Click CLOSE on the header and footer tool bar
FOOT NOTES AND END NOTES
· Footnotes and endnotes are used in large documents to explain, comment or provide reference for text in a document. Footnotes appear at the bottom of the page while endnotes appear at the end of a section or a document.
To insert footnote or endnote
· On the insert menu, point to reference and click footnote. A dialog box is displayed.
· In the location section, click footnotes or endnotes and specify the location of the footnotes or endnote
· In the format section, specify the number type start and continuity.
· Click insert.
CREATE AND MANIPULATING TABLES
· A table is made up of rows and column of cells. It is used to organize and present information in rows and columns
To create a table
· Click where you want to insert the table
· From the table menu, point to insert and then click table
· In the dialog box, set the number of the column and rows
· Specify the auto format option if needed to be
To delete rows or columns
· Select the row
· On the table menu, point to delete then click row/column
To insert rows or columns
· Click the insertion pointer where you want to insert the row/column
· On the table menu, point to insert then click/column
To merge cells
· Highlight the cells
· On the table menu, click merge cells
To split cells
· Highlight the cell to spilt
· On the menu, click split cell
· Enter number of rows or columns
Performing calculations in a table
· To calculate numerical values in a table, use cell references. A cell is a cross-section of rows and column. Column is represented by letter A, B, C. while rows are represented by 1, 2, 3…….as shown below
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· Place the insertion pointer to where you want the result to be displayed
· On the table menu, click formula
· Type a formula in the formula box e.g. = (A1 , E1)
· Click ok
· Note: you can select a formula from past function list and ABOVE and LEFT instead of typing a formula and using cell references respectively
Check for Errors
Printing a Document
Word processing is not complete without producing a hard copy
A hard copy (or "hardcopy") is a printed copy of information from a computer
Sometimes referred to as a printout , a hard copy is so-called because it exists as a physical object. The same information, viewed on a computer display or sent as an e-mail attachment, is sometimes referred to as a soft copy .
Perform Page Set Up
Perform Page Set Up
Preview a Document
Preview a Document
Print a Document
Print a Document
To print a document
· Preview it by click “print preview” on the file menu
· Click print from the file menu
· Select the printer range, number of copies and other options then the dialog box
Help Facility
Help Facility
Use Help Facility
The help facility has been included in the Windows operating system since Windows 95, the help files are installed as part of the installation. It looks different in every version of Windows but the basic idea is the same. You can usually press the “F1” key to access help regarding your current program.
Microsoft Word is a great word processing program but help button differ depending on which version you uses.
· Some users who upgrade from Word 2003/XP(2002)/2000 to 2007/2010/2013/2016 will find it hard to get the Help button, because all the buttons are relocated and organized in a new way. This article focuses on how to find out the Help button
Help Menu
Use help Menu
Just take Microsoft Word 2010 for example. With Classic Menu for Word 2007/2010/2013/2016 installed, you can click Menus tab to get back the classic style interface. The Help menu lies in the right most of the toolbar.
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If you have no Classic Menu for word installed
Method 1:
· The Help button in Word is too small that will be easily ignored. Actually the Help button stays in the top right corner of the window. The button looks like a question mark surrounded by a circle. The following picture shows its position. Or you can use the shortcut key F1 to enable the Help window.
Method 2:
· The Help menu has been added into the Word 2010 backstage. Click File, and you can find Help in the pane.
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Classic Menu for Office
· Classic Menu for Office is the software designed for the people who are accustomed to the old interface of Microsoft Office 2003, XP (2002) and 2000. It brings back the classic menus and toolbars to Microsoft Office (includes Word) 2007, 2010, 2013 and 2016. The classic view helps the people to smoothly upgrade to the latest version of Office, and work with Office 2007/2010/2013/2016 as if it were Office 2003 (and 2002, 2000).

Concept and Terminologies
The Spreadsheet Program
Describe the Spreadsheet Program
A spreadsheet is an interactive computer application for organization, analysis and storage of data in tabular form. Alternatively referred to as a worksheet, a spreadsheet is a file made of rows and columns that help sort data, arrange data easily, and calculate numerical data. Examples of spreadsheet programs are:
· Google sheet
· iWork numbers
· Libre Office
· Lotus 1-2-3
· Lotus Symphony
· Microsoft Excel
· Open Office
Today Microsoft Excelis the most popular and widely used spreadsheet program (figure 1)
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The Spreadsheet Terminologies
Explain Spreadsheet Terminology
TERMINOLOGIES USED IN SPEADSHEET (EXCEL)
· Cell - a space created on the spreadsheet / worksheet where a row and column meet
· Cell Address - the label for a cell made up of the column identifier and the row identifier. Example:A1 = column A, row 1 ,C5 = column C, row 5
· Cell Address Box- a rectangular box located at the top left corner of the spreadsheet containing the cell address of the current cell
· Cell Range - a group of cells that are highlighted (selected), or specified for use in a formula. A range includes the first cell address and the last cell address of cells either in a column or down a row. Example: =sum (B4:B10) - identifies all cells in the range from B4 to B10
· Chart / Graph – a visual representation of selected data. Charts help make the data easier to understand and “see”. Use the Chart icon or hit F11 for the chart feature. Some common chart types to choose from are: pie chart, line, column, bar, line etc.
· Current Cell - the cell that is active or selected and has a highlighted border
· Formula - a formula helps you to calculate and analyze data on your worksheet. Formulas contain cell references and mathematical operators (Remember, a function is like a keyword that is part of a formula.
There are 4 steps in creating a formula:
1. select the cell where you want the result of the formula to appear
2. key in the calculation / formula = B5*D5.
3. press Enter to “register” the entry
· Formula Bar - displays the formula of the selected cell. You may edit here.
· Function- is a pre-programmed, frequently used calculation. It is used as part of a formula and usually with a specific range of cells. Eg. = Sum (B1:B7) ; = Average (D4:D10) or = Avg (D4:D10) ; = Max (C5:C15);= Min (C5:C15)
· Labels – Textual information entered onto a worksheet cell. Could be column or row headings (Price, Quantity) or data entries such as student names.
· Relative Cell Reference - is a cell reference that changes when you copy a formula, or “fill” down a column or across a row. For example, the formula A1+A2+A3 will automatically change to B1+B2+B3 and then to C1+C2+C3 when copied or filled to those cells on the worksheet
· Value – Numeric information entered onto a worksheet cell. A value is any “raw” / unformatted number you enter, or results from a calculation on the spreadsheet 
· Workbook - contains sheets of different types – such as worksheets and chart sheets. Each Excel file is called a workbook. Each workbook is divided into several sheets, with a tab displayed for each. **Always name your worksheet, simply by highlighting “Sheet 1” and typing new name. 
· Worksheet - consists of rows (across) and columns (down) - like a blank sheet of graph paper. In a spreadsheet application; rows are numbered and columns are labeled A, B, C, D etc. An entire Spreadsheet worksheet could contain 256 columns across and 65,536 rows down.
Outline the Uses of Spreadsheet Program
Outline the Uses of Spreadsheet Program
The list of uses for spreadsheet software is endless. However the following are some of them;
· Modelling and Planning
· Household Finance Planning
· Business Accounts and Budgeting
· Invoices
· Wages
· Predictions / Simulations
· Calculations e.g. Adding, Subtracting, etc.
· Break even analysis
· Statistical analysis
· Creating Graphs e.g. bar chart, pie chart.
· Collect data from different sources e.g. phone number, prices.
· Explore and interpret data in order to draw conclusions for business
THE ADVANTAGES OF SPREADSHEETS
· Spreadsheets are preferable to manual calculation and recording of data for a variety of reasons, one very obvious reason is the unlimited space allowed to the user by the ‘spreadsheet’, hence the name.
Other Advantages Include:
· Calculations are correct
· Calculations are completed automatically
· Information is organized and easy to access
· Information is easy to edit if a mistake has been made by retyping or using ‘undo’
· Data can be easily sorted and filtered
· Data can be quickly analyzed
· Reports can be made more visual by using charts and graphs
Starting Ending Spreadsheet Program
Start a Spreadsheet Program
Start a Spreadsheet Program
Microsoft excel is one of the most popular spreadsheet processing programs supported by both Mac and PC platforms. The following steps will guide you in starting the Excel application.
· Click the Start button on the lower left corner of your computer screen.
· Click the All Programs arrow at the bottom left of the Start menu.
· Click the Microsoft Office folder on the Start menu. This will open the list of Microsoft Office applications.
· Click the Microsoft Excel 2010 option. This will start the Excel application
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End a Spreadsheet Program
End a Spreadsheet Program
Create a Workbook
Create a Workbook
Once Excel is started, a blank workbook will open on your screen. A workbook is an Excel file that contains one or more worksheets (sometimes referred to as spreadsheets). Excel will assign a file name to the workbook, such as Book1, Book2, Book3, and so on, depending on how many new workbooks are opened. Figure 3" shows a blank workbook after starting Excel.
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Your workbook should already be maximized (or shown at full size) once Excel is started, as shown in Figure 3 "Blank Workbook". However, if your screen looks like Figure 4 "Restored Worksheet" after starting Excel, you should click the Maximize button, as shown in the figure.
[image: https://sdimg.blob.core.windows.net/images/ShuleDirect/52671/Original/Capture3_1523244196228.png]
Open a Worksheet
Open a Worksheet
By default, Excel will remember your last modified worksheet as you exit your Excel program every time, and when you open your workbook next time, this sheet will be displayed first.
The following below are steps to open;
1. Click File > Open > Computer > Browse.
2. To only see files saved in the xlsx or Open Document Spreadsheet
3. Find the file you want to open, and then click Open.
Note: When you open an Open Document Spreadsheet file in Excel, it might not have the same formatting as it did in the original application it was created in. This is because of the differences between applications that use the Open Document Format.

Entering and Editing Data
Enter Data in Worksheet
Enter Data in Worksheet
There is more than one way to enter data into an Excel worksheet. Sometimes we stick to typing directly into cells, but there are different ways to enter data which can speed up your data entry work.
1. Type directly into a cell and add your data. You know a cell is active as it is highlighted with a darker border as in figure (5)
2. Use the formula bar. This is located under the ribbon. Type your data directly into the formula bar and press enter. You can navigate around the worksheet by typing the cell number directly into the Name box (located above the Columnheadings A – Z) as in figure (6)
3. Make the most of auto complete. Excel will try to help you speed up your data entry by guessing what you are typing based on what’s in your worksheet. If the auto correct option is right for you, just press enter as in fig (7)
4. Copy and paste – you may have cells that you can copy and paste data within the same worksheet – it can save you time formatting a sheet, or you can copy data to another worksheet within the workbook.
5. Let Auto fill do the work. Autofill options can complete series of data, whether it is text or numbers. This saves lots of data entry when setting up worksheets, or entering data.
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figure 5
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figure 6
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figure 7
Edit Data in Worksheet

Formatting Data in a worksheet
Formatting worksheet (or sheet) data is easier than ever. You can use several fast and simple ways to create professional-looking worksheets that display your data effectively. For example, you can use document themes for a uniform look throughout all of your 2007 Microsoft Office system documents, styles to apply predefined formats, and other manual formatting features to highlight important data.
The Various Formatting Features

Data Manipulation
Data manipulation is the process of changing data in an effort to make it easier to read or be more organized.
For example, a log of data could be organized in alphabetical order, making individual entries easier to locate.
Data manipulation is often used on web server logs to allow a website owner to view their most popular pages as well as their traffic sources. Users in the Accounting field or other fields that work with numbers often manipulate data to figure out costs of products, trends in sales, potential tax obligations, or how well merchandise is selling per week or month.
Stock market analysts are frequently using data manipulation to predict trends in the stock market and how stocks might perform in the near future. Computers may also use data manipulation to display information to users in a more meaningful way, based on code in a software program, web page, or data formatting defined by a user.
The Mathematical Operators
Identify Mathematical Operators
Operators specify the type of calculation that you want to perform on the elements of a formula, like addition, subtraction, multiplication or division. There is a default order in which calculations occur, but you can change this order by using parentheses
Different Types of Operators in Excel
	Types
	Character
	Operation
	Example

	Arithmetic
	+(plus sign)
	Addition
	=A2+B3

	
	-(minus sign)
	subtraction or negation
	=A3-A2 or -C4

	
	*(asterisk sign)
	multiplication
	=A2*B3

	
	/
	division
	=B3/A2

	
	%
	percent(dividing by 100)
	=B3%

	
	^
	exponentiation
	=A2^3

	Comparison/Logical
	=
	equal to
	=A2=B3

	
	>
	greater than
	=B3>A2

	
	<
	less than
	=A2<B3

	
	>=
	greater or equal
	=B3>=A2

	
	<=
	less or equal
	=A2<=B3

	
	<>
	not equal to
	=A2<>B3

	Text
	&
	concatenates (connects) entries to produce one continuous entry
	=A2&” “&B3t

	Reference
	:(colon)
	Range operator that includes
	=SUM(C4:D17)

	
	,(coma)
	Union operator that combines multiple references into one reference
	=SUM(A2,C4:D17,B3

	
	space
	Intersection operator that produces one reference to cells in common with two references
	=SUM(C3:C6 C3:E6)


Most of the time, you’ll rely on the arithmetic operators when building formulas in your spreadsheets that don’t require functions because these operators actually perform computations between the numbers in the various cell references and produce new mathematical results. The comparison operators, on the other hand, produce only the logical value TRUE or the logical value FALSE depending on whether the comparison is accurate.
Data manipulation in spreadsheet including the following but not limited to this ;
· creating new data by transforming existing data
· cell references (relative and absolute)
· selecting or highlighting data
· sorting data
· deleting rows or columns of data
CREATE NEW DATA BY TRANSFORMING EXISTING DATA
· Suppose you have open a data set with the following information (cars.xls).

Now additionally create data on cars per person in household. This data will be included in cells C2:C6 under the heading CARS PER PERSON. To do this
· In cell C2 type =A2/B2 (then cell C2 is the entry in A2 divided by that in B2)
· Cut and paste to change the remaining entries in column C. Highlight cell C2 and copy by CTRL-C or by Edit / Copy. Then highlight cells C3:C6 and paste by CTRL-V or by Edit / Paste.
· Finally in cell C1 type CARS PER PERSON.

The ability to manipulate data like this is a great attraction of spreadsheets.
REFERENCES
· Cell reference examplesare;
· Cell B2 is the entry in column B and row 2.
· Cells B2:C10 are the entries from column B row 2 in the top left to column C row 10 in the bottom right. This is 2 columns times 9 rows yielding 18 entries.
· Cell references are most often relative but can also be absolute. Absolute cell references have the prefix $. For example, B2:C10 is a relative cell reference while $B$2:$C$10 is an absolute cell reference.
CELL
Relative cell references can change after copying the cell references to a new location. For example, if D2 = B2+C2 then if we copy cell D2 to D3 (move down one cell) the new cell is D3 = B3+C3.
Absolute cell references do not change after copying the cell references to a new location. For example, if D2 = $B$2+$C$2 then if we copy cell D2 to D3 (move down one cell) the new cell is D3 = $B$2+$C$2.
Cell references can be part relative and part absolute For example, $B2 is absolute column B and relative row 2, while B$2 is relative column B and absolute row 2. Cell references can be to a different worksheet in the current workbook For example, Sheet name! B2:C10 or Sheet name !$B2:$B10. Cell references can be to a different workbook For example, (Workbook name) Sheet name B2:C10 or (Workbook name) Sheet name! $B2:$B10.
SELECTING OR HIGHLIGHTING DATA
· Many Excel commands involve selecting or highlighting data. Do this by
· Click on the first entry in the array.
· Depress the shift key and keep it depressed
· Scroll down to the last entry in the array you want to highlight
· Click on this last entry
For long arrays this can require a lot of scrolling. CTRL-down arrow moves automatically to the bottom of an array. CTRL-up arrow moves to the top,. CTRL-right arrow to the right end of the arrow and so on
· Thus to select or highlight all the data
· Click on the first entry in the array (upper left corner).
· Depress the shift key and keep it depressed
· Hit CTRL-down arrow
· Hit CTRL-right arrow
SORT DATA
· Suppose we wish toorderthe newly created data in descending order by cars per person.
· Highlight cells A1:C6
· Choose the Data Tab and the Sort and Filter Group and Sort This opens the Sort Dialog box
· Sort by CARS PER PERSON from largest to smallest.

DELETE ROWS OR COLUMNS OF DATA
· In most cases we wish to delete an entire row or column. If you just highlight the row or column and hit the delete key then the contents disappear but the row or column (now blank) remains. Instead click on the shaded row number or column letter and then right-click and choose delete. Alternatively highlight the row(s) and column(s) to delete and then choose Edit | Delete and select delete all row or delete all column.
The Usage of Mathematical Operators
Use Mathematical Operators
The Predefined Formula / Functions
Use Predefined Formula / Functions
Charts
It can often be difficult to interpret Excel workbooks that contain a lot of data. Charts allow you to illustrate your workbook data graphically, which makes it easy to visualize comparisons and trends.
The Various Type of Charts
Identify Various Type of Charts
Types of charts are:
· Pie chart
· Line chart
· Column chart
· Bar chart
· Area chart
· Scatter chart
Create Charts
Create Charts
To insert a chart:
· Select thecellsyou want to chart, including thecolumn titlesandrow labels. These cells will be thesource datafor the chart. In our example, we'll select cells A1:F6.

From the Insert tab, click the desired Chart command. In our example, we'll select Column.

Choose the desired chart type from the drop-down menu.

The selected chart will be inserted in the worksheet.

If you're not sure which type of chart to use, the Recommended Charts command will suggest several different charts based on the source data.

Edit Charts
Edit Charts
Chart layout and style
· After inserting a chart, there are several things you may want to change about the way your data is displayed. It's easy to edit a chart's layout and style from the Design tab.
· Excel allows you to add chart elements —such as chart titles, legends, and data labels—to make your chart easier to read.
· To add a chart element, click the Add Chart Element command on the Design tab, then choose the desired element from the drop-down menu.

To edit a chart element, like a chart title, simply double-click the place holder and begin typing.

If you don't want to add chart elements individually, you can use one of Excel's predefined layouts. Simply click the Quick Layout command, then choose the desired layout from the drop-down menu.

Excel also includes several different chart styles, which allow you to quickly modify the look and feel of your chart. To change the chart style, select the desired style from the Chart styles group

You can also use the chart formatting shortcut buttons to quickly add chart elements, change the chart style, and filter the chart data.

Other chart options
· There are many other ways to customize and organize your charts. For example, Excel allows you to rearrange a chart's data, change the chart type, and even move the chart to a different location in the workbook.
To switch row and column data:
· Sometimes you may want to change the way chartsgroupyour data. For example, in the chart below, the Book Sales data are groupedbyyear, with columns foreachgenre. However, we could switch the rows and columns so the chart will group the databy genre, with columns foreachyear. In both cases, the chart contains the same data—it's just organized differently.

· Select the chart you want to modify.
· From the Design tab, select the Switch Row/Column command.

· The rows and columns will be switched. In our example, the data is now grouped by genre, with columns for each year.

To change the chart type
· If you find that your data isn't well suited to a certain chart, it's easy to switch to a new chart type. In our example, we'll change our chart from a Column chart to a Line chart.
· From the Design tab, click the Change Chart Type command.

The Change Chart Type dialog box will appear. Select a new chart type and layout, then click OK. In our example, we'll choose a Line chart.

The selected chart type will appear. In our example, the line chart makes it easier to see trends in the sales data over time.

To move a chart:
· Whenever you insert a new chart, it will appear as an object on the same worksheet that contains its source data. Alternatively, you can move the chart to a new worksheet to help keep your data organized.
· Select thechartyou want to move.
· Click the Design tab, then select the Move Chart command.

· The Move Chart dialog box will appear. Select the desired location for the chart. In our example, we'll choose to move it to a new sheet, which will create a new worksheet.
· Click OK.

· The chart will appear in the selected location. In our example, the chart now appears on a new worksheet.

Printing a Worksheet
You can print entire or partial worksheets and workbooks, one at a time, or several at once. And if the data that you want to print is in a Microsoft Excel table, you can print just the Excel table. You can also print a workbook to a file instead of to a printer. This is useful when you need to print the workbook on a different type of printer from the one that you originally used to print it.
Perform Page Setup
Perform Page Setup
Preview a Worksheet
Preview a Worksheet

Help Facility
The Office Help Facility
Use Office Help Facility
Help button on Classic Menus
· With Classic Menu for Excel 2007/2010/2013/2016 installed, you can click Menus tab to get back the classic style interface. The Help menu lies in the right most of the toolbar.


Help button on Ribbon Interface
· The Help button in Excel is too small that will be easily ignored. Actually the Help button stays in the top right corner of the window. The button looks like a question mark surrounded by a circle. The following picture shows its position. Or you can use the shortcut key F1 to enable the Help window.

Introduction to Local Area Network (LAN) and Wide Area Network (WAN)
The Computer Network
Describe a Computer Network
A network can be defined as a group of computers and other devices connected in some ways so as to be able to exchange data. Each of the devices on the network can be thought of as a node; each node has a unique address. Addresses are numeric quantities that are easy for computers to work with, but not for humans to remember. Example: 204.160.241.98 Some networks also provide names that humans can more easily remember than numbers. Example: www.javasoft.com, corresponding to the above numeric address.
A computer network This is a digital telecommunications network which allows nodes to share resources. In computer networks, networked computing devices exchange data with each other using a data link. The connections between nodes are established using either cable media or wireless media.
The Local area Network (LAN)
Explain Local area Network (LAN)
LOCAL AREA NETWORK (LAN)
· Local Area Network is privately owned communications network that spans a small geographic area, such as single building or buildings close to each other. May be school or college campus Examples: Ethernet, Local Talk, Token Ring, FDDI, ATMIn addition to operating in a limited space in limited space, LANs are also typically owned, controlled and manage by a single person or organization. Most of the LANs are built with relatively inexpensive hardware such as Ethernet cables, network adapters, and hubs
WIDE AREA NETWORK (WAN)
· Wide Area Network is a computer network that can span a very large geographic area, e.g., multiple cities, countries, continents or even across the word. Examples: ARPANET, X.25, Frame Relay, SMDS, ATM Internet is the largest WAN, spanning the earth. WAN is the geographically dispersed collection of LANs. A communication devices called router can connect LANs in to WAN. WAN differ from LAN in several ways. Most of the WANs are not owned by any organization but rather exist under collective or distributed ownership and management.
The table below shows the difference between LAN and WAN.
	FEATURE
	LAN
	WAN

	Scale of sharing
	Less and limited
	Far greater and worldwide

	Communication media
	Uses cable such as coaxial and UTP
	Satellite, microwaves or telecommunication links

	Installation cost
	Low
	High

	Network coverage
	Small area, over a single building or college campus
	Cities, state and countries


The Accessories Used for Computer Network Connections
List of Accessories Used for Computer Network Connections
Computer network components include the major parts that are needed to install a network both at the office and home level. Before delving into the installation process, you should be familiar with each part so that you could choose and buy the right component that fits with your network system.
These hardware components include cable, Hub, Switch, NIC (network interface card), modem and router. Depending on the type of network you are going to install, some of the parts can be eliminated. For example, in a wireless network you don’t need cables, hubs so on.
Computer network requires the following devices (some of them are optional):-
· Network Interface Card (NIC)
· Hub Switches
· Cables and connectors
· Router Modem
NETWORK INTERFACE CARD (NIC)
· This is a device that enables a computer to talk with other computer/network. Using unique hardware addresses (MAC address)encoded on the card chip, the data-link protocol employs these addresses to discover other systems on the network so that it can transfer data to the right destination.
There aretwo types of network cards: 
a. Wired
b. Wireless
The wired NIC uses cables and connectors as a medium to transfer data, whereas in the wireless card, the connection is made using antenna that employs radio wave technology. All modern laptop computers incorporated wireless NIC in addition to the wired adapter.

HUB
· Hub is a device that splits a network connection into multiple computers. It is like a distribution center. When a computer request information from a network or a specific computer, it sends the request to the hub through a cable. The hub will receive the request and transmit it to the entire network. Each computer in the network should then figure out whether the broadcast data is for them or not. Currently Hubs are becoming obsolete and replaced by more advanced communication devices such asSwitches and Routers.

SWITCH
· This is a telecommunication device grouped as one of computer network components. Switch is like a Hub but built in with advanced features. It uses physical device addresses in each incoming messages so that it can deliver the message to the right destination or port.Like Hub, switch don’t broadcast the received message to entire network, rather before sending it checks to which system or port should the message be sent. In other words switch connects the source and destination directly which increases the speed of the network. Both switch and hub have common features: Multiple RJ-45 ports, power supply and connection lights.
CABLES AND CONNECTORS
· Cable is one way of transmission media which can transmit communication signals. The wired network typology uses special type of cable to connect computers on a network.There are a number of solid transmission Media types, which are listed below.
Twisted pair wire It is classified as Category 1, 2, 3, 4, 5, 5E, 6 and 7. Category 5E, 6 and 7 are high-speed cables that can transmit 1Gbps or more.
Coaxial cable Coaxial cable more resembles like TV installation cable. It is more expensive than twisted-pair cable but provide high data transmission speed.
Fiber-optic cable It is a high-speed cable which transmits data using light beams through a glass bound fibers. Fiber-optic cable is high data transmission cable comparing to the other cable types. But the cost of fiber optics is very expensive which can only be purchased and installed on governmental level.
ROUTER
When we talk about computer network components, the other device that used to connect a LAN with an internet connection is called Router.
When you have two distinct networks (LANs) or want to share a single internet connection to multiple computers, we use a Router.In most cases, recent routers also include a switch which in other words can be used as a switch. You don’t need to buy both switch and router, particularly if you are installing small business and home networks.
There are two types of Router: wired and wireless. The choice depends on your physical office/home setting, speed and cost.
MODEMS
A modem enables you to connect your computer to the available internet connection over the existing telephone line. Like NIC, Modem is not integrated with a computer motherboard. It comes as separate part which can be installed on the PCI slots found on motherboard.A modem is not necessary for LAN, but required for internet connection such as dial-up and DSL.There are some types of modems, which differs in speed and transmission rate.
Standard PC modem or Dial-up modems (56Kb data transmission speed), Cellular modem (used in a laptop that enables to connect while on the go),cable modem (500 times faster than standard modem)and DSL Modems are the most popular.
The Importance of Computer Networks
Explain the Importance of Computer Networks
ADVANTAGES OF COMPUTER NETWORKS
A network is two or morecomputersconnected together to share information and files between them. Businesses aren't the only ones that can benefit from creating a network. Home users can enjoy sharing music, movies andprintersfrom anycomputer. Computer network provides several advantages which include but not limited to the following:
1. It enhances communication and availability of information. Networking, especially with full access to the web, allows ways of communication that would simply be impossible before it was developed. Instant messaging can now allow users to talk in real time and send files to other people wherever they are in the world, which is a huge boon for businesses. Also, it allows access to a vast amount of useful information, including traditional reference materials and timely facts, such as news and current events.
2. It allows for more convenient resource sharing. This benefit is very important, particularly for larger companies that really need to produce huge numbers of resources to be shared to all the people. Since the technology involves computer-based work, it is assured that the resources they wanted to get across would be completely shared by connecting to a computer network which their audience is also using.
3. It makes file sharing easier. Computer networking allows easier accessibility for people to share their files, which greatly helps them with saving more time and effort, since they could do file sharing more accordingly and effectively.
4. It is highly flexible. This technology is known to be very flexible, as it gives users the opportunity to explore everything about essential things, such as software without affecting their functionality. Plus, people will have the accessibility to all information they need to get and share.
5. It is an inexpensive system. Installing networking software on your device would not cost too much, as you are assured that it lasts and can effectively share information to your peers. Also, there is no need to change the software regularly, as mostly it is not required to do so.
6. It increases cost efficiency. With computer networking, you can use a lot of software products available on the market which can just be stored or installed in your system or server, and can then be used by various workstations.
7. It boosts storage capacity. Since you are going to share information, files and resources to other people, you have to ensure all data and content are properly stored in the system. With this networking technology, you can do all of this without any hassle, while having all the space you need for storage
Despite of the aforementioned benefits, computer networks are likely to have the following disadvantages.
1. It lacks independence. Computer networking involves a process that is operated using computers, so people will be relying more of computer work, instead of exerting an effort for their tasks at hand. Aside from this, they will be dependent on the main file server, which means that, if it breaks down, the system would become useless, making users idle.
2. It poses security difficulties. Because there would be a huge number of people who would be using a computer network to get and share some of their files and resources, a certain user’s security would be always at risk. There might even be illegal activities that would occur, which you need to be careful about and aware of.
3. It lacks robustness. As previously stated, if a computer network’s main server breaks down, the entire system would become useless. Also, if it has a bridging device or a central linking server that fails, the entire network would also come to a standstill. To deal with these problems, huge networks should have a powerful computer to serve as file server to make setting up and maintaining the network easier.
4. It allows for more presence of computer viruses and malware. There would be instances that stored files are corrupt due to computer viruses. Thus, network administrators should conduct regular check-ups on the system, and the stored files at the same time.
5. Its light policing usage promotes negative acts. It has been observed that providing users with internet connectivity has fostered undesirable behavior among them. Considering that the web is a minefield of distractions—online games, humor sites and even porn sites—workers could be tempted during their work hours. The huge network of machines could also encourage them to engage in illicit practices, such as instant messaging and file sharing, instead of working on work-related matters. While many organizations draw up certain policies on this, they have proven difficult to enforce and even engendered resentment from employees.
6. It requires an efficient handler. For a computer network to work efficiently and optimally, it requires high technical skills and know-how of its operations and administration. A person just having basic skills cannot do this job. Take note that the responsibility to handle such a system is high, as allotting permissions and passwords can be daunting. Similarly, network configuration and connection is very tedious and cannot be done by an average technician who does not have advanced knowledge.
7. It requires an expensive set-up. Though computer networks are said to be an inexpensive system when it is already running, its initial set up cost can still be high depending on the number of computers to be connected. Expensive devices, such as routers, switches, hubs, etc., can add up to the cost. Aside from these, it would also need network interface cards (NICs) for workstations in case they are not built in.
Network Physical Topologies
The Different Network Topologies
Identify Different Network Topologies
The term “Topology” refers to the way in which the end points or stations/computer systems, attached to the networks, are interconnected.
Network topology defines the way in which computers, printers and other devices are connected or Network topology is the arrangement of the various elements (links, nodes, etc.) of a communication network.
The topology you choose to implement will influence many factors in the way your network works. When we refer to a network topology, we may be referring to its physical or its logical topology.
Physical topology refers to the way in which a network is laid out physically, the actual layout of the wire or media, two or more devices connect to a link, and two or more links form a topology.
Logical topology defines how the hosts access the media to send data. Shows the flow of data on a network.
Logical Topology
· The logical topology of a network determines how the hosts communicate across the medium. The two most common types of logical topologies are broadcast and token passing.The use of a broadcast topology indicates that each host sends its data to all other hosts on the network medium. There is no order that the stations must follow to use the network. It is first come, first serve. Ethernet works this way as will be explained later in the course.The second logical topology is token passing. 
· In this type of topology, an electronic token is passed sequentially to each host. When a host receives the token, that host can send data on the network. If the host has no data to send, it passes the token to the next host and the process repeats itself. Two examples of networks that use token passing are Token Ring and Fiber Distributed Data Interface (FDDI). A variation of Token Ring and FDDI is Arcnet. Arcnet is token passing on a bus topology.
The Network Physical Topologies
Explain Network Physical Topologies
TYPES OF PHYSICAL TOPOLOGIES
Physical topologies are defined purely by the way in which the networking media connects the devices. A diagram of the physical topology of a network shows the physical path of the media take to reach each of the devices on the network. Depending on the requirements, there are different topologies to construct a network.
1. Mesh topology
2. Star topology
3. Tree topology
4. Bus topology
5. Ring topology
6. Cellular topology
1. Mesh topology
· In a mesh topology, every device has a dedicated point-to-point link to every other device. The term dedicated means that the link carries traffic only between the two devices it connects. To connect n nodes in Mesh topology, we require n (n-1)/2 duplex mode links.
One practical example of a mesh topology is the connection of telephone regional offices in which each regional office needs to be connected to every other regional office.

2. Star topology
· In a star topology, each device has a dedicated point-to-point link only to a central controller, usually called a hub. The devices are not directly linked to one another. Unlike a mesh topology, a star topology does not allow direct traffic between devices. The controller acts as an exchange: If one device wants to send data to another, it sends the data to the controller, which then relays the data to the other connected device.

3.Ring topology
· In a ring topology, each device has a dedicated point-to-point connection with only the two devices on either side of it. A signal is passed along the ring in one direction, from device to device, until it reaches its destination.Each device in the ring incorporates a repeater. When a device receives a signal intended for another device, its repeater regenerates the bits and passes them along. A ring is relatively easy to install and reconfigure. Each device is linked to only its immediate neighbours (either physically or logically). To add or delete a device requires changing only two connections. The only constraints are media and traffic considerations (maximum ring length and number of devices). In addition, fault isolation is simplified. Generally in a ring, a signal is circulating at all times. If one device does not receive a signal within a specified period, it can issue an alarm. The alarm alerts the network operator to the problem and its location.However, unidirectional traffic can be a disadvantage. In a simple ring, a break in the ring (such as a disabled station) can disable the entire network. This weakness can be solved by using a dual ring or a switch capable of closing off the break.However, unidirectional traffic can be a disadvantage. In a simple ring, a break in the ring (such as a disabled station) can disable the entire network. This weakness can be solved by using a dual ring or a switch capable of closing off the break.

4.Bus topology
A networking topology that connects networking components along a single cable or that uses a series of cable segments that are connected linearly. A network that uses a bus topology is referred to as a “bus network.” Bus networks were the original form of Ethernet networks, using the 10Base5 cabling standard. Bus topology is used for:
· Small work-group local area networks (LANs) whose computers are connected using a thin net cable
· Trunk cables connecting hubs or switches of departmental LANs to form a larger LAN
· Back boning, by joining switches and routers to form campus-wide networks

5. Tree topology
· Tree Topology integrates the characteristics of Star andBus Topology. Earlier we saw how in Physical Star network Topology, computers (nodes) are connected by each other through central hub. And we also saw in Bus Topology, work station devices are connected by the common cable called Bus. After understanding these two network configurations, we can understand tree topology better. In Tree Topology, the number of Star networks are connected using Bus. This main cable seems like a main stem of a tree, and other star networks as the branches. It is also called Expanded Star Topology. Ethernet protocol is commonly used in this type of topology.

6.Cellular topology
· The cellular topology is applicable only in case of wireless media that does not require cable connection. In wireless media, each point transmits in a certain geographical area called a cell. Each cell represents a portion of the total network area. Devices that are in the cell communicate through a central hub. Hubs in different cells are interconnected. They route data across the network and provide a complete network infrastructure. The data is transmitted in the cellular digital packet data (CDPD) format.
The Advantages and Disadvantage of each Topology
State Advantages and Disadvantages of each Topologies
Advantages of mesh topology
· The use of dedicated links guarantees that each connection can carry its own data load, thus eliminating the traffic problems that can occur when links must be shared by multiple devices.
· Robust, if one link becomes unusable, it does not incapacitate the entire system.
· Advantage of privacy or security.
· Point-to-point links make fault identification and fault isolation easy, Traffic can be routed to avoid links with suspected problems.
Disadvantages of mesh topology
· Required high amount of cabling and the number of I/O ports.
· The sheer bulk of the wiring can be greater than the available space (in walls, ceilings, or floors) can accommodate.
· The hardware required to connect each link (I/O ports and cable) can be prohibitively expensive.
Advantages of star topology
· Less Expensive than mesh topology.
· In a star topology, each device needs only one link and one I/O port to connect it to any number of other devices. This factor also makes it easy to install and reconfigure.
· Less Cabling, Addition and Deletion involves only one connection between the devices and the Hub or Switch.
· Easy for Fault identification and fault isolation. If one link fails, only that link is affected.
Disadvantages of star topology
· One big disadvantage of a star topology is the dependency of the whole topology on one single point, the hub. If the hub goes down, the whole system is dead.
Advantages of ring topology
· Performs better than a bus topology under heavy network load
· Does not require network server to manage the connectivity between the computers
· Very orderly network where every device has access to the token and the opportunity to transmit
Disadvantages of ring topology
· One malfunctioning workstation or bad port in the MAU can create problems for the entire network
· Moves, adds and changes of devices can affect the network
· Network adapter cards and MAU's a Multistation Access Unit are much more expensive than Ethernet cards and hubs
· Much slower than an Ethernet network under normal load
Advantages of bus topology
· Easy to install
· Costs are usually low
· Easy to add systems to network
· Great for small networks
Disadvantages of bus topology
· Out of date technology.
· include difficult reconnection and fault isolation
· Can be difficult to troubleshoot.
· Unmanageable in a large network
· If cable breaks, whole network is down
Advantages of Tree Topology
· It is an extension of Star and bus Topologies, so in networks where these topologies can't be implemented individually for reasons related to scalability, tree topology is the best alternative.
· Expansion of Network is possible and easy.
· Here, we divide the whole network into segments (star networks), which can be easily managed and maintained.
· Error detection and correction is easy.
· Each segment is provided with dedicated point-to-point wiring to the central hub.
· If one segment is damaged, other segments are not affected.
Disadvantages of Tree Topology
· Because of its basic structure, tree topology, relies heavily on the main bus cable, if it breaks whole network is crippled.
· As more and more nodes and segments are added, the maintenance becomes difficult.
· Scalability of the network depends on the type of cable used.
Advantages of cellular topology
· Troubleshooting is easy
· Hub to hub fault tracking is more complicated, but allows simple fault isolation.
Disadvantages of cellular topology
· When the central hub fails, all the unit in the assigned range of cell are affected.

Concepts of Internet
The Internet
Descibe the Internet
Internet is a wide world connection of computer which enables sharing of resource like files and folders, picture and music, teaching materials like notes / tutorials and computers.
This is the global system of interconnected computer networks that use the Internet protocol suite (TCP/IP) to link devices worldwide. Communication between networks is called inter networking. Therefore internet comes from the word inter networking meaning a connection of data communication. The communication in which the end instruments are computers. The internet is a worldwide public networks that interconnect thousands of smaller networks to form one large “web” of communication.
Many private networks, some with thousands of users of their own connect to the internet by using the services of internet services providers (ISPs )
In simple words internet is a huge number of computers that are connected to each other throughout the world. These computers are situated in many different countries and are connected through telephone lines, cables in the ground and even satellite in spaces.
The Historical Development of Internet
Explain the Historical Development of Internet
Internet involved from US Department of defense project called ARPANET (Advanced Research Project Agency Network) in 1969. The main reason was to exchange information between researchers in this project. Browses and Word Wide Web (WWW) were introduced in early 1990’s.
Search Engine
Describe Search Engine
A search engine is a web site that collects and organizes content from all over the internet
Search engines are programs that search documents for specified keywords and returns a list of the documents where the keywords were found
This is a program that searches for and identifies items in a database that correspond to keywords or characters specified by the user, used especially for finding particular sites on the World Wide Web
The List of Search Engine
List Search Engine
Example of search engines are:
· Google
· Bing
· Yahoo
· Ask.com
· AOL.com
· Baidu
TYPES OF SEARCH ENGINE
· INDIVIDUAL
· META
Web search engine
· A web search engine is a software system that is designed to search for information on the World Wide Web. The search results are generally presented in a line of results often referred to as search engine results pages (SERPs). The information may be a mix of web pages, images, and other types of files. Some search engines also mine data available in databases or open directories. Unlike web directories, which are maintained only by human editors, search engines also maintain real-time information by running an algorithm on a web crawler.
Access Information using Search Engine
Internet Application: Electronic Mail
The Electronic Mail 
Explain Electronic Mail 
This is a method of exchanging messages between people using electronic devices. Or Electronic mail (email) is a digital mechanism for exchanging messages through Internet or intranet communication platforms
They comprise of:
· User ID
· The Symbol @
· Domain name
The domain:
· Its located after @
· Tells the location and types of address
· Provides information about where about the message should be delivered
Root Domain
Describes the type of location; currently there six root domain
1. com: commerce organization
2. edu: education / research organization
3. go: government organization
4. mil: military organization
5. net: gateway host network
6. Org: nonprofit or miscellaneous organization
Some domain name will also include the country name e.g. UK: England or tz: TANZANIA Example of e-mail address are:
· abdulzabibu@gmail.com
· User ID: abdulzabibu
· Domain name: gmail.com
· Domain (location): gmail
Advantages of e-mail
· it’s free! Once you’re online, there is no further expense.
· Easy to reference Sent and received messages and attachments can be stored safely, logically and reliably. It's a lot easier to organize emails than paper.
· Easy to use Once you’re set up, sending and receiving messages is simple. That goes for a host of other email functions. Data storage and contacts can be accessed quickly and easily.
· Easy to prioritize Incoming messages have subject lines that mean you can delete without opening. How much time does that save compared to ‘snail mail?
· Speed Message to send, Done, under a second! Email is as fast a form of written communication as any.
· Global Web based email means you can access your messages anywhere online. Going overseas? Before you go, mail yourself a copy of your passport number, travel insurance details or your accommodation details.
· Good for the planet Actually the advantages and disadvantages of email are clear here. Computers themselves aren’t 'green', but email offsets some of the damage by reducing the environmental cost of contact.
· Info at your finger tips Storing data online means less large, space taking file cabinets, folders and shelves. You can access information far quicker if you learn how to use email this way.
· Leverage Send the same message to any number of people. Adaptations are simple, too. If you have a product or service to sell, email is an effective medium to get your message out.
· Send reminders to yourself Email yourself messages from work to home or vice versa. Does the idea of two or more accounts seem complicated? It's not if you know how to manage multiple accounts.
Disadvantages of e-mail
· Emails may carry viruses. These are small programs that harm your computer system. They can read out your email address book and send themselves to a number of people around the world.
· Many people send unwanted emails to others. These are called spam mails. It takes a lot of time to filter out the unwanted emails from those that are really important.
· Emails cannot really be used for official business documents. They may be lost and you can not sign them.
· Your mailbox may get flooded with emails after a certain time so you have to empty it from time to time.
The Uses of Electronic Mail
Outline the Uses of Electronic Mail
Email is like sending a letter; the only difference is instead of using pen and paper, you use keyboard to type a message on computer.
Benefits of Email
· It is more personal and direct medium for communication.
· Messages are delivered within seconds around the world.
· It allows to save and keep a record of your communication.
· Easy to send with no time boundation.
· Good example of One-To-Many communication.
· You may attach files, documents, images, and other media to an email.
· You can access your email from anywhere with Internet connection kept on.
· Activate your filters and receive only genuine mails.
Create an Electronic Mail Address
Create an Electronic Mail Address
The Electronic Mail with other Communication Media
Compare Electronic Mail with other Communication Media
Internet Application: Electronic Learning 
The Electronic Learning 
Explain Electronic Learning
E-learning is the learning conducted via electronic media, typically on the Internet
Or E-learning is electronic learning, and typically this means using a computer to deliver part, or all of a course whether it's in a school, part of your mandatory business training or a full distance learning course.
Or E-Learning is learning utilizing electronic technologies to access educational curriculum outside of a traditional classroom.
The Advantages of Electronic leaning
List Advantages of Electronic Leaning
Advantages Of E-Learning
· You are able to link the various resources in several varying formats.
· It is a very efficient way of delivering courses online.
· Due to its convenience and flexibility, the resources are available from anywhere and at any time.
· Everyone, who are part time students or are working full time, can take advantage of web-based learning.
· Web-based learning promotes active and independent learning.
· As you have access to the net 24x7, you can train yourself anytime and from anywhere also.
· It is a very convenient and flexible option; above all, you don't have to depend on anyone for anything.
· Not only can you train yourself on a day to day basis, but also on weekends or whenever you have the free time to. There is no hard and fast rule.
· Through discussion boards and chats, you are able to interact with everyone online and also clear your doubts if any.
· The video instructions that are provided for audio and video learning can be rewound and seen and heard again and again if you do not happen to understand the topic first time around.
Disadvantages Of E-Learning
Well, there are not many disadvantages of eLearning, the main one being that you get knowledge only on a theoretical basis and when it comes to putting to use whatever you have learnt, it may be a little different. The face-to-face learning experience is missing, which may matter to some of you.
· Most of the online assessments are limited to questions that are only objective in nature.
· There is also the problem of the extent of security of online learning programs.
· The authenticity of a particular student's work is also a problem as online just about anyone can do a project rather than the actual student itself.
· The assessments that are computer marked generally have a tendency of being only knowledge-based and not necessarily practicality-based.
Internet Application: Electronic Commerce
The Electronic Commerce
Explain Electronic Commerce
This is commercial transactions conducted electronically on the Internet. Or This is a transaction of buying or selling online Or This is a term for any type of business, or commercial transaction that involves the transfer of information across the Internet.
It covers a range of different types of businesses, from consumer based retail sites, through auction or music sites, to business exchanges trading goods and services between corporations. It is currently one of the most important aspects of the Internet to emerge
ADVANTAGES OF ECOMMERCE
· Faster buying/selling procedure, as well as easy to find products.
· Buying/selling 24/7.
· More reach to customers, there is no theoretical geographic limitations.
· Low operational costs and better quality of services.
· No need of physical company set-ups.
· Easy to start and manage a business.
· Customers can easily select products from different providers without moving around physically.
DISADVANTAGES OF ECOMMERCE
· Any one, good or bad, can easily start a business. And there are many bad sites which eat up customers’ money.
· There is no guarantee of product quality.
· Mechanical failures can cause unpredictable effects on the total processes.
· As there is minimum chance of direct customer to company interactions, customer loyalty is always on a check.
· There are many hackers who look for opportunities, and thus an ecommerce site, service, payment gateways, all are always prone to attack.
The Application of Electronic Commerce
Outline Application of Electronic Commerce
eCommerce development and its applications is an unavoidable sector in the present day today life. Given below are the most common eCommerce applications.
· Retail & wholesale; There are numerous applications for retail as well as wholesale in case of ecommerce. Here comes e-retailing or may be called as online retailing. This refers to the selling of goods and other services through electronic stores from business to consumers. These are designed and equipped using shopping cart model and electronic catalog.
· Marketing; Using web and ecommerce, data collection about the following are possible 1. Preferences 2. Behaviour 3. Needs 4. Buying patterns The marketing activities like price fixing, product feature and its enhancement, negotiation, and the relationship with the customer can be made using these. 
· Finance; eCommerce is being used by the financial companies to a large extent. By the name finance we know that there will be customers and transactions. The customers can check the balance in their savings account, as well as their loan account. There are features like transferring of money from and to their own accounts, paying of bills online and also e-banking. Online stock trading is also another feature of ecommerce. 
· Manufacturing; eCommerce is included and used in the chain operations (supply) of a company. There are companies that form electronic exchange. This is by providing buying and selling items together, trading market information and the information of runback office like inventory control. This is a way that speeds up the flow of finished goods and the raw materials among the business community members.
· Auctions; eCommerce customer to customer is direct selling of goods among customers. It includes electronic auctions that involve bidding system. Bidding allows prospective buyers to bid an item. In Airline Company they give bidding opportunity for customers to quote the price for a seat on specific route, date and time. 
· Entertainment; eCommerce application is widely used in entertainment area also for video cataloging, multiplayer games, interactive ads and for online discussion. 
· Education; In educational training also ecommerce has major role for interactive education, video conferencing, online class and for connecting different educational training centers.
· Negative Effect of the Internet
· The Internet Uses that Negatively Affect our Culture
· Outline Internet Uses that Negatively Affect our Culture
· Lack Of Face To Face Communication
· It sounds quite ironic when the lack of face to face communication is mentioned as one of the negative effects of Internet because the Internet is supposed to bring people closer.
· But the fact is that somehow many people find it easier to communicate through the Internet instead of the traditional direct way. They prefer to discuss over Messenger, Viber or other apps available on the Internet. The idea of taking face to face is becoming a tough decision.
· Research issued in the International Journal of Organizational Design and Engineering has stated that the face to face communication in teamwork helps people build mutual trust, creative and provide a higher result.
· To know more information, please click at: How 20 Interpersonal communication skills, activities, and strategies.When teenagers and students and tend to choose Internet communication and avoid talking directly, their personal relationships with friends and family will be affected.
· According to The Washington Post survey and its result, about 6% of participants replied that their relationships got hurt as a consequence of excessive Internet use. It is believed that some people who prefer online chatting because it somehow separates them from the real world.
· Lack Of Creativity
· The lack of creativity in teenagers and students is also another one of negative effects of Internet rooting from its benefits. One significant feature of Internet is the unlimited sources of information. This feature benefits users by quick access to needed info at ease. However, when everything is available, there is no need for creativity. Students now don’t have to pay much effort on their assignment or project because they only need a few minutes to get all information they need from the Internet then copy paste into their work. This problem is a warning for the increase in plagiarism, leading to the lack of creativity. When this habit happens several times, these young people will be dependent on the Internet to finish their studying. The same situation happens to not only students but also to users at any age. Things get easier in a way that it becomes a hindrance for learning and creativity.
· Cyber Bullying
· Cyber bullying is basically a term to describe the bullying using the Internet. This disadvantage can be considered as one of the evilest negative effects of Internet. It is never easier for haters to give ugly words toward a person. Celebrities or some kinds of people in protected class are often the victims of cyber bullying. This type of harassment is safer and easier than physical bullying because there is hardly any regulation or law to control the problems. Victims of cyber bullying may feel insulted or embarrassed because of the wicked comments or opinions. The negative effects will be worse on teenagers, especially on those who are in puberty with all the vulnerability and sensitiveness. There is a positive relationship proved between cyber bullying and suicidal attempts by victims. Students are considered to be most bullied on the Internet. A couple of criticism from teachers or cheating from groups of friends can drive a student insane and finally to suicide.
· Waste Of Time
· It will be a mistake to forget the waste of time when it comes to the negative effects of Internet. The Washington Post revealed that 9% attempted to hide “nonessential Internet use.” In addition, Stanford University also conducted a study showing that 12.4 percent of participants stayed online for a longer time than they intended very often. It is obvious that if you spend too much time on the Internet, you will have to cut down on time for other activities. As an infinite storage of entertainment, the Internet is somehow similar to the black hole that leaves no way to get out. A lot of students and teenagers spend most of their time just on watching films, surfing Facebook and playing games instead of learning or doing other meaningful activities. If the original purpose of Internet was to help students and teenagers work more efficiently, it now makes them do no work at all. Especially for students, the explorations and advancement of Internet turn it into a promising distraction. As the result, their academic result goes down gradually while the electronic bill payment keeps increasing.
· Abandonment of Family
· The excessive using of anything always creates side effects. The Internet is not an exception. When students and teenagers use of Internet is too much, the abandonment of family will occur as one of the negative effects of Internet. The tragedy of a couple in Korea will be the most appropriate example for this effect because they were so busy with their virtual baby and forget about their real baby. Finally, this poor baby died of hunger and of the abandonment of his parents. When people spend most of their time on surfing the Internet, they become insensitive to the real life and people around them, including members of their own family. Obviously, the original purpose of parents when they equip their children with the Internet is to open a door to the new world, not to close themselves in a fiction planet without family. For many students, the Internet is the only friend they have. The time for family, for parents is replaced by hours of Internet browsing. They ignore the family and hesitate to talk or interact with other members.
· Privacy Disrupted
· Occurring due to the free information flow of Internet, privacy threat is one of the negative effects of Internet that you should know about. Teenagers exchange their picture, private information or personal chat every day in social networking. Many students even update their ID number, their class number and other information relating to personal security. They are not fully aware of the risk privacy threat that their information can be easily approached by strangers and be misused. Their privacy stands a risk of being disrupted and hindered. Therefore, keep in mind that not everything is exchangeable on the Internet. For your best benefits and to stay away of these negative effects of Internet, be careful with all the private information you upload and make sure who is available to reach your information.
· Insomnia
· For anyone does not know what insomnia is, it is a sleeping disorder that happens when people are not able to rest or sleep. And the powerful global system, the Internet, somehow is one of the reasons for insomnia. It cannot be denied that teenagers and students are sticking with the Internet all day. They take advantages of any time possible to browsing the Internet, even the sleeping time. Just after several days, they stay up late to check their Facebook or Instagram, it will become a habit and believe me, it is not easy to get rid of it. Moreover, the green light from the computer screen or other types of electronic items can keep you away from your sleep. If you concern about insomnia We all know that staying up late is not good for our health. When the body cannot have enough time to rest, many health problems will appear
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